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Status

RIBA and its members uphold high standards of professional competence. This document sets out best 
practice guidance for members and for RIBA Chartered Practices. Adherence to this guidance is not 
compulsory but members and Chartered Practices should use their judgment to determine when to follow 
such guidance and to what extent. RIBA cannot accept liability for when and how members and Chartered 
Practices apply guidance published by RIBA.

Having an audit trail showing that the member took account of the practices contained in RIBA guidance 
may provide a partial defence to an allegation of negligence. When seeking an independent expert report to 
defend such a case, the expert is likely to reference relevant RIBA guidance as a measure of reasonable skill 
and care. 

RIBA regularly reviews its RIBA guidance, to take into account changes in the legal and regulatory compliance 
environment. However, it is each member’s responsibility to ensure they keep up to date with legal and 
regulatory compliance regimes, supported by RIBA CPD compliance requirements and RIBA standards 
material as this is published and reviewed from time to time. 

Members are reminded that ARB Standards of Conduct (for all Registered Architects) and the RIBA Code of 
Conduct (for Chartered members) and RIBA Code of Practice (for Chartered Practices) impose requirements 
for holding suitable professional indemnity insurance to cover potential liabilities arising from negligence or 
breach of contract associated with professional activities.
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Foreword

 I don’t believe that anyone will ever be able to forget the tragic fire that  I don’t believe that anyone will ever be able to forget the tragic fire that 
we all woke up to on 14 June 2017. In the intervening four years the we all woke up to on 14 June 2017. In the intervening four years the 
construction industry has realised that apart from the horrific loss of construction industry has realised that apart from the horrific loss of 
72 lives, the tragedy has exposed us all to the public gaze – and we have 72 lives, the tragedy has exposed us all to the public gaze – and we have 
come up wanting. It is desperately sad to learn that this could have been come up wanting. It is desperately sad to learn that this could have been 
prevented, and that it took a horror of such a shocking scale to prompt prevented, and that it took a horror of such a shocking scale to prompt 
change from the Government and industry.change from the Government and industry.

2021 marks the beginning of a long overdue comprehensive regulatory 2021 marks the beginning of a long overdue comprehensive regulatory 
reform of our safety systems, where we expect to see the Government reform of our safety systems, where we expect to see the Government 
outline the biggest changes to safety law and enforcement in 40 years. outline the biggest changes to safety law and enforcement in 40 years. 
The RIBA has been vociferous in its advocacy for clearer, stronger and The RIBA has been vociferous in its advocacy for clearer, stronger and 
enforceable regulations to ensure the safety of the public and protect enforceable regulations to ensure the safety of the public and protect 
their human right to sleep safely in their homes. In an ever increasingly their human right to sleep safely in their homes. In an ever increasingly 
complex design and construction industry, we also need to review the complex design and construction industry, we also need to review the 
fire safety competence of our membership, and assure their readiness fire safety competence of our membership, and assure their readiness 
to face the challenges ahead. I am delighted that, in order to ensure that to face the challenges ahead. I am delighted that, in order to ensure that 
Chartered architects are at the forefront of the cultural and professional Chartered architects are at the forefront of the cultural and professional 
changes required, the RIBA plans to introduce mandatory competences changes required, the RIBA plans to introduce mandatory competences 
for UK Chartered Members. for UK Chartered Members. 

The RIBA Fire Safety Compliance Tracker will enable practices to The RIBA Fire Safety Compliance Tracker will enable practices to 
track and record their projects’ design development, and demonstrate track and record their projects’ design development, and demonstrate 
compliance with Building Regulations Part B – Fire Safety. It will help compliance with Building Regulations Part B – Fire Safety. It will help 
to guide design decision making, and increase confidence in fire safety to guide design decision making, and increase confidence in fire safety 
coordination. It’s an excellent and critical tool, which I hope you will use coordination. It’s an excellent and critical tool, which I hope you will use 
and adapt going forwards.and adapt going forwards.

Jane Duncan OBE
RIBA President 2017-19 
Chair of the RIBA Expert Advisory Group on Fire Safety
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Introduction
The construction industry is facing significantly challenging times as a consequence of 
the Grenfell Tower fire in 2017 and the legal and commercial implications arising from 
the Grenfell Inquiry, the Hackitt Review and changes in Building Regulations. Professional 
indemnity insurers have reacted by reducing their exposure, resulting in rising premiums 
and limitations on fire safety related advice placed on the PII policies of the majority of 
architects and other built environment consultants. RIBA members are increasingly asked 
to demonstrate the fire safety risk profile of their projects to insurance brokers through a 
variety of different questionnaires. 

The RIBA Fire Safety Compliance Tracker is intended as a template for RIBA members to use 
to track and record a project’s design development and routes to compliance with Building 
Regulations Part B – Fire Safety. Following completion of the project, this tracker may be 
used to help answer questions from insurance brokers or others, providing them with a more 
detailed record of fire safety design decisions for compliance with building regulations, in a 
straightforward format. 

The template is intended to be used by the practice in one of two ways:

A.  When taking a leadership role in providing fire safety design coordination, this template 
may be used to provide compliance information to the design team. 

B.  When a fire engineer is leading fire safety design coordination, the template may be used 
internally within your practice to help your team track compliance and to confirm the 
architectural design aligns with the fire strategy. 

The RIBA recognise there maybe value to members in sharing this information with their 
client to demonstrate how they have addressed fire safety in design decision making, or 
with the wider project team for design risk management purposes. RIBA members should 
exercise their judgement in deciding whether the template should be shared with the client 
or project team.
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The International Fire Safety Standard:  
Common Principles
The RIBA Fire Safety Compliance Tracker draws on the International Fire Safety Standard: Common 
Principles (IFSS-CP) and its associated Framework.

Over time the construction industry has learned fundamental fire safety principles for preventing fire events 
and managing their impact (i.e. the Common Principles: Prevention, Detection and Communication, Occupant 
Protection, Containment and Extinguishment) that can be consistently applied internationally.

The IFSS-CP primarily focuses on the information required for life safety from fire and aims to minimise the 
social and economic impact of fire on communities. IFSS-CP establishes overarching, performance-based 
Common Principles for fire safety engineering design, construction, occupation, and ongoing management. 
IFSS-CP is intended to be flexible and non-prescriptive so that it can be adopted incrementally and will also 
advance good practice. 

The Common Principles become actionable through the IFSS-CP Framework, which enables evidence-based 
assessment to achieve fire safety engineering design, construction, occupation, and ongoing management on 
a Building level. The IFSS-CP Framework is the collective application of the Common Principles, which apply 
to different stages in the Building Life Cycle.

The RIBA recommends that RIBA members consider using the full IFSS-CP for sharing fire safety 
information with their project teams. The objectives of the IFSS Common Principles are listed below. 

• Prevention Principle
  Safeguarding against the outbreak of fire and/or limiting its effects.

• Detection and Communication Principle
  Investigating and discovering of fire followed by informing occupants and the fire service.

• Occupant Protection Principle
  Facilitating occupant avoidance of and escape from the effects of fire.

• Containment Principle
  Limiting of fire and all of its consequences to as small an area as possible.

• Extinguishment Principle
  Suppressing of fire and protecting of the surrounding environment.

The RIBA Fire Safety Compliance Tracker applies the structure set out in the IFSS-CP Framework, but is 
only compliant with the design decision section of the IFSS rather than the full lifecycle as this is the area 
relevant to architects’ design liability. The full list of fire safety measures included in the template are also 
listed in this guide, aligned to the overarching requirements of Part B and set out according to each IFSS 
Common Principle.
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Principle: Prevention

– Occupant behaviour
– Natural and man-made disasters
– Process safety in use
– Distance to external hazards

Requirement B1 
Means of warning and escape

Principle: Detection and Communication

– Detection systems 
– Warning systems
– Fire service communications
– Building configuration

Principle: Occupant Protection

– Evacuation procedures
– Evacuation plans 
– Protected areas
– Smoke control
– Smoke lobbies
– Locations of fire doorsets
– Travel distances
–  Means of escape and alternative means of 

escape
– Potential restrictions en route 
– Exit and stair capacities
– Merging population flows
– Corridor widths
– Evacuation lifts
– Emergency power supply
– Emergency lighting
– Emergency exit signage
– Assembly points
– Evacuation equipment
– Occupant characteristics

Requirement B2 
Internal fire spread (linings)

Principle: Containment

–  Selection of internal lining materials to adequately 
resist the spread of fire

– Thermoplastic materials

Requirement B3 
Internal fire spread (structure)

Principle: Containment

– Fire door and shutter sets
– Fire-rated glazing
– Fire resilient ductwork and dampers
– Fire-stopping
– Cavity barriers
– Protected shafts
– Firestopping systems
– Sprinklers / automatic fire suppression systems
– Structural fire protection
–  Fire resilient structure and compatibility with 

compartmentation design
– Ventilation

Requirement B4 
External fire spread

Principle: Containment

– Resisting fire spread over external walls
– Resisting fire spread over the roof
– Resisting fire spread from one building to another

Requirement B5 
Access and facilities for the fire service

Principle: Extinguishment

–  Proximity to the nearest fire department and fire 
service arrival time

–  Parking conditions and external access routes for 
the fire and rescue services

–  Protection to the internal firefighting access 
routes 

– Fire control room
– Dry risers
– Wet risers
– Impact of water run off
– Firefighting lifts
– Firefighting lobbies
– Manual firefighting equipment 
– Wayfinding signage for fire and rescue services
– Structural resilience for firefighter safety
– Availability of building information

Principles of Fire Safety Measures 
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How to use the Fire Safety 
Compliance Tracker
The template has been developed to enable RIBA members to track and record compliance with fire safety 
requirements using the following headings:

Project Details
This table allows RIBA members to identify the roles being provided on the project, as well as setting out the 
details of the project and any defining characteristics (such as the project height, storeys, M2, use etc). There 
is also provision to input the documents date and version control, which can be kept updated alongside the 
project’s development.

Where a project is being developed over several phases, it is expected that a new template will be developed 
for each phase.

RIBA Plan of Work Stages
At each stage of the project, design submissions and approvals by the client can be tracked, alongside any 
specific project notes. Following a stage approval, this template can be saved and filed alongside each of the 
projects stage approvals, to be maintained as an independent record copy. 

Statutory Compliance
Completing and updating the template during the project’s design development stages will provide a 
high-level snapshot of the project’s statutory compliance against Planning / Gateway 1, Building Control / 
Gateway 2 and Completion / Gateway 3, alongside any approval conditions. 

Fire Safety Measures to be Included
The template is structured using Part B of the Building Regulations and uses the five Common Principles 
from the IFSS. Each section of the template is populated with a list of the key fire safety measures that may 
be required in a project to comply with Part B of the Building Regulations.

Although an extensive list of key fire safety measures has been provided, this is not exhaustive and additional 
fire safety measures can be added to ensure that all the appropriate measures for the project are tracked. 

Dependent upon the project type and scale, not all the key fire safety measures may be required in a project. 
A checkbox against each measure for the principles of Detection and Communication, Occupant Protection, 
Containment and Extinguishment, can be used to identify if the measure is to be included in the project. 

The initial template (‘Safeguard against the outbreak of fire’) outlines the IFSS Principal of Prevention, which 
provides the means to broadly identify and document the risks that may give rise to the potential for a fire 
to occur. This provides a set of overarching considerations that may influence the development of fire safety 
measures.
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Responsibility
The template provides space to identify who is taking lead responsibility for designing each fire safety 
measure, with a secondary role identifier that may be contributing to the development of the measure. This 
may be more than one entity including the RIBA member and should be used to record if they have provided 
design advice in relation to the measure. This dropdown list can be duplicated to enable you to add further 
roles as appropriate. 

Where a measure is assigned to a role that is not available in the dropdown list, you can edit the list to add or 
amend the roles displayed. 

To enable this functionality, you will need to add the ‘Developer’ Tab to the ribbon in Microsoft Word (File > 
Options > Customize Ribbon, and under Main Tabs, select the Developer check box). Once this functionality 
is added, you can select the dropdown list you plan to amend, click the ‘Developer’ Tab, and then 
‘Properties’ (under ‘Controls’), which will bring up a dialogue box with the appropriate editing functionality 
so you can make changes.

Route to Compliance and Design Considerations
The template allows the RIBA member to record the route to compliance used, signposting to where 
guidance or the processes followed (ADB, British Standards, CFD, QDR, Fire and Rescue Service etc) in 
relation to the respective fire safety measure design decision can be found, as well as any accompanying 
notes on the decisions taken. Completion of this section can also include an extract or snapshot from the 
document where guidance was taken and inserted into the table. Any documents referenced within the route 
to compliance should be captured with their date and any identifying numbering or version control.

Design Status
The design status for each fire safety measure that is included within the project can be tracked against 
4 stages:
• Design in Progress (DP)
• Design Complete (DC)
• Design Approved (Building Control) (DA)
• Constructed and Signed Off (CS)

At any one time, only one box within the design status for each measure may be checked. A design should 
not be considered complete until all necessary measures are approved, however if your appointment ceases 
or the client hands over responsibility to another member of the project team, it may not be possible for 
you to complete this process. Dependent upon your scope of services, you may not be able to complete the 
design status for all 4 stages.

Following any statutory submission, where fire safety measures are not approved, or where an approved 
design solution is impacted by subsequent design decisions, these measures should be reassessed and 
unchecked as ‘Design Complete’ or ‘Design Approved’, and rechecked as ‘Design in Progress’, until any 
necessary amendments to the design are completed.
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Fire Safety Compliance Tracker – 
Completed Sample
The table below shows an extract of the ‘Occupant Protection’ compliance table, which has been based on a 
7 storey multi occupancy residential building, to show how the compliance tracker can be completed. 

IF
SS

Fire safety 
measures 

to be included
Responsibility

Route to compliance & Design Considerations
Guidance or processes followed (ADB, British Standards, CFD, QDR, 

Fire and Rescue Service etc)
Document version / extract / accompanying notes

Design status

DP DC DA CS

   
 O

cc
up

an
t P

ro
te

ct
io

n

Evacuation 
procedures
(such as 
delayed 
(including stay 
put), phased, 
progressive and 
simultaneous)

✓ Lead: fire 
engineer
Contributor: 
architect

BS 9991: 2015
BS 9999: 2017
London Plan Policy D12

Flats
A ‘stay put’ evacuation strategy is followed initially (except the flat of 
origin). An Evacuation Alert System with live voice communication 
controlled by the Fire and Rescue Service on site can instigate phased 
evacuation.

In the event of a fire, the occupants of the flat of the fire origin (and all 
flats if instructed) will evacuate into the common corridor which leads 
to two protected stairs. These stairs discharge either at lower ground 
or upper ground. 

Basement Plant Rooms
The basement plant rooms will operate an independent simultaneous 
evacuation strategy.

✓

Evacuation 
plans 
(such as GEEPs 
and PEEPs)

Lead: Select Role
Contributor: 
Select Role

Protected areas
(such as stairs, 
corridors and 
lobbies, refuge 
areas)

✓ Lead: architect
Contributor: fire 
engineer

BS 9991: 2015

Each level is provided with two protected stairs, a firefighting stair 
accessed via the fire-fighting lift lobby and a secondary escape stair 
with a protected lobby accessed from the common corridor offering 
alternative means of escape. Disabled refuges are provided within the 
fire-fighting lobby and secondary stair lobby at each level. Protected 
corridors are provided which link directly to the final exits at upper and 
lower ground floor.

✓

Smoke control
(such as passive 
or mechanical, 
ventilation 
shafts)

✓ Lead: building 
services engineer
Contributor: fire 
engineer
Contributor: 
architect

BS 9991: 2015

Three mechanical smoke shafts will be provided. The shafts within the 
common corridors will be reversible to ensure smoke is always pulled 
away from the stair that opens into the corridor. The shaft within the 
fire-fighting lift lobby will be an extract shaft. 

CFD analysis to be carried out.

✓

Smoke lobbies ✓ Lead: architect
Contributor: 
Select Role

BS 9991: 2015
BS 9999: 2017 

Smoke lobbies will be provided adjacent to firefighting and secondary 
escape stairs.

✓

Locations of fire 
doorsets

✓ Lead: architect
Contributor: fire 
engineer

BS 9991: 2015
BS 9999: 2017 

Fire doorsets are to achieve a minimum FD 30s. 

✓

Travel distances ✓ Lead: architect
Contributor: fire 
engineer

BS 9991: 2015

Travel distances from flats to either protected stair lobby are within 
30m.

✓

Means of 
escape and 
alternative 
means of 
escape

✓ Lead: architect
Contributor: fire 
engineer

BS 9991: 2015

Two stairs are provided, one at each end of the building.
✓
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Building and Fire Safety Reforms
The draft Building Safety Bill takes forward reforms of the building safety system in response to the 
Building a safer future consultation, providing the Health and Safety Executive with powers to improve 
Building Standards and to oversee a new and more stringent regime for higher-risk buildings. It also outlines 
improvements in building safety and performance standards for all buildings, extending the dutyholder roles 
set out in the Construction (Design and Management) Regulations 2015 (CDM 2015).

RIBA members need to keep abreast of these changes, as the duties for fire safety measures may only be 
allocated to specific roles identified in future legislation. The RIBA will update this guide and its associated 
template following any related changes to legislation. 

The RIBA has long been campaigning for thorough reforms of the building safety regulatory system to create 
a safer built environment. You can access our consultation responses to Government and other published fire 
safety material on www.architecture.com/firesafety
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